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Registrar-se  
 
Siga estas etapas para criar uma conta de usuário Pix4D: 

1. Clicar no link ou copie e colá-lo em seu navegador:  ​https://cloud.pix4d.com/signup/ 
2. Preencha a página de inscrição com suas informações:

 
3. Clicar em ​CREATE ACCOUNT​.  
4. Um email de verificação será enviado para ativar a conta. Abra o e-mail e clique em 

Confirm my email​. 
5. A conta de usuário Pix4D é criada e ativada. 
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Resgatar 
Se a licença ainda não tiver sido atribuída à sua conta por meio de uma compra de 
e-commerce. O resgate da licença garante que você é o proprietário de sua licença.  
 
Primeiro, certifique-se de que você tem uma conta Pix4D. Caso contrário, crie uma conta Pix4D 
conforme descrito na seção ​Registar-se​. As etapas para resgatar a licença são: 
 

1. Clicar no link em ​Activation Instructions ​no ​License Certificate​ que você recebeu ao 
adquirir a licença Pix4D. Ou acesse o seguinte link: 
https://cloud.pix4d.com/license-redeem/  

2. Digite o código de licença na caixa abaixo:

 
3. Clicar ​Redeem​ e assim a licença está atribuida à sua conta.  

 

Hardware - Computador 
A descrição a seguir mostra os requisitos de hardware e software mínimos e recomendados 
para assegurar um bom funcionamento do software​: 
  
Mínimo​: 

● Windows 7, 8, 10, Server 2008, Server 2012, 64bits  (PC ou ​computadores​ Mac ​que 
usam​ Boot Camp). 

● Qualquer CPU (Intel i5/ i7/ Xeon ​recomendado​). 
● Qualquer GPU ​que seja compatível com​ OpenGL 3.2. (Plaques ​gráficas integradas​ Intel 

HD 4000 ou melhor). 
● Pequenos projetos (menos de 100 imagens em 14 MP) ​4 GB RAM, 10 GB ​de espaço 

disponível no HDD. 
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● Projetos médios (entre 100 e 500 imagens a 14 MP): 8 GB de RAM, 20 GB de espaço 
disponível no HDD. 

● Grandes projetos (entre 500 e 2000 imagens a 14 MP): 16 GB de RAM, 40 GB de 
espaço disponível no HDD​. 

● Projetos muito grandes (mais de 2000 imagens a 14 MP): 16 GB de RAM, 80 GB de 
espaço disponível no HDD​. 

 
Recomendado​: 

● Windows 7, 8, 10 64 bits. 
● CPU quad-core ou hexa-core Intel i7/Xeon. 
● GeForce GPU compatível com OpenGL 3.2 e 2 GB RAM. 
● DiscoDuro: SSD. 
● Pequenos projetos (menos de 100 imagens a 14 MP): 8 GB de RAM, 15 GB de espaço 

disponível SSD​. 
● Projetos médios (entre 100 e 500 imagens a 14 MP): 16 GB de RAM, 30 GB de espaço 

disponível SSD.  
● Grandes projetos (mais de 500 imagens a 14 MP): 32 GB de RAM, 60 GB de espaço 

livre SSD​. 
● Projetos muito grandes (mais de 2000 imagens a 14 MP): 32 GB de RAM, 120 GB de 

espaço disponível SSD​. 
 

Baixar e instalar o software 
 
Em qualquer momento existem duas versões disponíveis para o download: 

● Pix4D Desktop: Esta versão destina-se a trabalhos de produção. 
● Pix4D Desktop Preview: Esta versão contém os recursos mais recentes, mas não se 

destina para o trabalho de produção.  

Download 
Para fazer o download do software: 

1. Acesse:​ ​https://cloud.pix4d.com/download/​. 
2. Baixe o Pix4D Desktop ou o Pix4D Desktop Preview. 

Instalação 
Depois que o software tiver sido baixado, instale-o seguindo as seguintes etapas: 

1. Clicar duas vezes no arquivo baixado. O assistente de configuração Pix4Dmapper é 
iniciado. 

2. (opcional): Se aparecer o menu ​Open file - Security Warning​, clicar em ​Run​. .
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3. Na janela pop-up do ​Pix4Dmapper Setup​, na tela ​Welcome to the Pix4Dmapper Setup 

Wizard​, clicar em ​Next >. 
4. (opcional) Clicar em ​Browse...​ para alterar o caminho de destino da instalação e clicar 

em​ Next >​. 

 
5. Clicar em ​Install​. 
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6. (opcional) Na janela de informações do software: "​ Do you want to allow the following 

program to install software on this ​computer?"  Clicar em  ​Yes​. 
7. Clicar em ​Finish​. 
8. Quando a instalação é concluída, um atalho é criado na sua área de trabalho e o 

software é aberto automaticamente. 
9. A primeira vez que o software é aberto, aparece a janela de início de sessão do 

Pix4Ddesktop Login​: 

 
10. Digite o Email e a Senha da conta e clique em ​Login​.  
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11. Leia o Contrato ​End-User License Agreement​, selecione ​I accept the terms in the 
License Agreement​ e clique em ​Next​. 

12. Selecione uma destas opções: 
a. Request Pix4Dmapper now (Free Trial)​ para ativar um teste de 15 dias. 
b. Use Pix4Ddiscovery​ para ativar a versão limitada. 
c. Choose a license​ ​para selecionar entre as licenças existentes na conta​. 

13. Clicar em ​OK​. 
  
Pix4D Desktop está agora pronto para iniciar um processamento. 

Configuração de idioma  
Você pode alterar as configurações de idioma no Pix4D Desktop a qualquer momento: 

1. Abra o Pix4Dmapper  
2. Na barra de menus clique ​Help > Settings…
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3. A janela settings vai abrir-se:  

 
 
4. Clique na secção ​Language​ tab. 
5. Na secção ​Select the User Interface Language​, selecione a língua que pretende. 
6. Clique ​OK​. 
7. As alterações terão efeito quando o software for reiniciado. 

Atualizar 
As versões mais recentes do Pix4D Desktop e Pix4D Desktop Preview estão sempre 
disponíveis para download, conforme descrito na seção ​Download​. 
 
Além disso, se uma nova versão do Pix4D Desktop estiver disponível, um pop-up de 
atualização,​ Software Update​, com três opções será exibido quando o software for aberto: 

1. Download and Install Now​ Para baixar e instalar a versão mais recente disponível. 
2. Remind Me Later​ para não baixar ou instalar a versão mais recente. O pop-up 

aparecerá novamente em 10 dias.  
3. Cancel​ para não baixar ou instalar a versão mais recente. Nenhum lembrete aparecerá.  

Desactivação da Licença  
A partir da versão 4.0, foi implementado um novo mecanismo de gerenciamento de licenças, 
permitindo desativar remotamente um dispositivo,para isso: 
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1. Baixe a versão mais recente do Pix4D Desktop a partir da ​página de download​. 
2. Saia do Pix4D Desktop. 
3. Acesse o ​painel de gerenciamento de licenças.  
4. Na sua licença Pix4Dmapper, ao lado de ​30 days license check, clique ​Enable now​:  

 
5. Faça login no Pix4D Desktop,o dispositivo ficará automaticamente registrado no painel de 
gerenciamento de licenças. 
6. Para desativar o dispositivo, acceda ​o painel de gerenciamento de licença​ e ao lado do nome 
do dispositivo para desativar, clique em ​Deactivate.  

Entradas 
As entradas principais para o Pix4Dmapper são as imagens que podem ser arquivos JPEG ou 
TIFF. 

Aviso​: Não modifique as imagens, ou seja, não gire ou edite as imagens. A modificação de 
imagens altera as propriedades geométricas da câmara e pode deteriorar a qualidade dos 
resultados. 

Extensão Descrição 

.jpg, .jpeg JPEG images 

.tif, .tiff Monocromático TIFF 

Multi-banda TIFF (RGB / infravermelho / 
térmica) 

1 camada (sem pirâmide, sem multi-página) 

8, 10, 12, 14, 16 bit Inteiro, floating point 

Saídas 
Pix4Dmapper pode gerar essas saídas:  
 

● Camera parameters​ (​Internal parameters​, ​External parameters​, ​Bingo​, ​SSK​): Estes 
ficheiros descrevem os parâmetros internos (distância focal, ...) ou externos (posição e 
orientação) da câmara e das imagens.  

● Undistorted images​, ​Imagens não distorcidas 
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● Densified Point Cloud ​(​.las, .laz, .xyz, .ply​)​: Este é um conjunto de pontos 3D que 
reconstruem o modelo. A posição X, Y, Z e as informações de cor são armazenadas 
para cada ponto da nuvem de pontos densificados. 

● Digital Surface Model​ (​Grid DSM​, ​Raster DSM​): Este é um modelo digital da superfície 
2.5D da área mapeada que contém informações (X,Y,Z), mas sem informações de cor. 

● Digital Terrain Model​ (​DTM​: ​Raster DTM​): ​Este é um Modelo Digital do Terreno 2.5D da 
área mapeada após a filtragem de objetos, tais como edifícios, que contém informações 
(X,Y,Z), mas nenhuma informação de cor​. 

● Orthomosaic​ (​GeoTIFF​, ​KML file​, ​Google Maps HTML file​): ​Modelo de Mosaico 2D 
(mapa) feito misturando as várias ortofotos e cor equilibrada para ser visualmente 
agradável​. 

● Index Map​ (​GeoTIFF​, ​Colored KML file​, ​Grid Shapefile​): ​A cada valor de índice é 
associado um mapa de índice. Para cada pixel neste mapa, o valor do pixel é derivado 
dos mapas de reflectância associados.  

● 3D Textured Mesh​ (​.obj, .fbx, .dxf, .ply, .pdf​): Esta é uma representação da forma do 
modelo que consiste em vértices, arestas, faces e a textura das imagens que é 
projetada sobre eles. É útil para apresentar e visualizar o modelo, compartilhá-lo e 
enviá-lo para plataformas on-line, como o Sketchfab. 

● Contour lines​ (​shp, .pdf, .dxf​): Estas são linhas que ligam pontos de igual elevação. São 
úteis porque permitem compreender melhor a forma da superfície terrestre (a 
topografia) num mapa.  

● Video animation ​(​.mp4, .mkv, .avi​) Animação em vídeo. 
● 3D Digitized objects: Polyline, Surface, Volume base surface​ (​.shp, .dxf,.kml, .dgn​): 

Estes são objetos digitalizados ou computados. 

Plano de Aquisição de Imagens 
O plano de aquisição de imagens depende dos seguintes fatores: 

● Tipo de ​Terreno​ / ​Objecto​ a reconstruir.  
● Ground Sampling Distance (GSD)​: O tamanho do GSD exigido pelas especificações 

do projeto definirá a distância (altura de vôo) na qual as imagens devem ser tiradas. Por 
exemplo, um GSD de 5 cm significa que um pixel na imagem representa linearmente 5 
cm no chão (5 * 5 = 25 centímetros quadrados). 

● Overlap​: A sobreposição depende do tipo de terreno que é mapeado e determinará a 
frequência com que as imagens devem ser tomadas. 

 
Um plano de aquisição de imagens incorreto levará a resultados imprecisos ou falha de 
processamento e exigirá a aquisição de imagens novamente. 
 
Todos os ​Planos de vôo​ descritos abaixo podem ser voados automaticamente com o aplicativo 
de planejamento de vôo ​Pix4Dcapture​ disponível no Android e iOSn. 
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Caso Geral 
Para a maioria dos casos, recomenda-se adquirir as imagens com um ​padrão de grade 
regular. A superposição recomendada é de pelo menos ​75% de sobreposição frontal​ (em 
relação à direção de voo) e pelo menos ​60% de sobreposição lateral​ (entre faixas de voo). A 
câmara deve ser mantida o máximo possível a uma ​altura constante​ sobre o terreno / objeto 
para garantir o GSD desejado.  

 
 
A sobreposição e a altura de voo têm que ser ​adaptadas dependendo do terreno.  
 
Para a floresta, áreas de vegetação densa e terrenos planos com campos agrícolas, 
recomenda-se aumentar a sobreposição a pelo menos 85% de sobreposição frontal e pelo 
menos 70% de sobreposição lateral e voar mais alto de modo que seja mais fácil detectar 
semelhanças entre imagens sobrepostas. Projetos com imagens térmicas requerem pelo 
menos 90% de sobreposição frontal e lateral.  
 
Em projetos com ​voos múltiplos​, deve haver uma sobreposição entre os diferentes voos e as 
condições (direção solar, condições meteorológicas, novos edifícios, etc.) devem ser 
semelhantes. 

Reconstrução de edifícios 
Para a reconstrução de um edifício é recomendado um plano de voo circular. 
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● Voar ao redor do prédio pela primeira vez com um ângulo de câmara de 45 °. 
● Voar uma segunda e terceira vez em torno do edifício aumentando a altura do vôo e 

diminuindo o ângulo da câmara em cada rodada.  
● Recomenda-se tirar uma imagem a cada 5 a 10 graus para garantir uma sobreposição 

suficiente, dependendo do tamanho do objeto e da distância a ele. Mais imagens devem 
ser tomadas para distâncias mais curtas e objetos maiores. 

 
Nota: A altura do vôo não deve ser aumentada mais de duas vezes entre todos os vôos, pois 
diferentes alturas levam a diferentes GSD. 
 

Reconstrução da cidade - fachadas visíveis 
A reconstrução 3D de áreas urbanas requer um plano de aquisição de imagem de grade dupla, 
de modo que todas as fachadas de edifícios (norte, oeste, sul, leste) são visíveis nas imagens. 
A sobreposição deve ser a mesma da secção ​Caso Geral​.  
Para que as fachadas sejam visíveis, as imagens devem ser tomadas com um ângulo entre 10º 
e 35º. 
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Modelos de opções de processamento 
Os ​Processing Options Templates ​são modelos de opções de processamento padrão 
disponíveis no Pix4Dmapper. É altamente recomendável usar estes para processar seus 
projetos. 

Modelos de opções de 
processamento 

Descrição 

3D Maps 
Saídas​: modelo 3D (nuvem de pontos, malha 3D texturizada), 
bem como um DSM e Orto/mosaico. 
Entrada típica​: imagens aéreas adquiridas usando um plano de 
vôo de grade. 
Aplicações​: pedreiras, cadastro, etc 

3D Models 
Saídas​: modelo 3D (nuvem de pontos, malha de textura 3D). 
Entrada típica​: qualquer imagem com sobreposição elevada. 
Aplicação​: modelos 3D de edifícios, objectos, imagens de solo, 
imagens interiores, inspeção, etc. 
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Ag Multispectral 
Saídas​: reflectância, índice (como NDVI), classificação e mapas 
de aplicação. 
Entrada típica​: imagens de câmeras multiespectrais (Sequoia, 
Micasense RedEdge, Multispec 4C, etc). 
Aplicação​: agricultura de precisão 

Ag Modified Camera Saídas​: reflectância, índice (como NDVI), classificação e mapas 
de aplicação. 
Entrada típica​: imagens de câmeras RGB modificadas. 
Aplicação​: agricultura de precisão. 

Ag RGB Saídas​:  orto/mosaico. 
Entrada típica​: câmeras RGB para agricultura (Sequoia RGB). 
Aplicações​: scouting digital, relatório que reivindica para a 
agricultura de precisão. 

3D Maps - Rapid/Low 
Res 

Processamento mais rápido do modelo do ​3D Maps​ gerando 
menor precisão, assim como saídas de baixa resolução. 

3D Models - Rapid/Low 
Res 

Processamento mais rápido do modelo ​3D Models​ gerando menor 
precisão, bem como saídas de baixa resolução. 

Ag Modified Camera - 
Rapid/Low Res 

Processamento mais rápido do modelo ​Ag Modified Camera 
gerando menor precisão, bem como saídas de menor resolução. 

Ag RGB - Rapid/Low 
Res 

Processamento mais rápido do modelo ​Ag RGB,​ gerando menor 
precisão, assim como saídas de baixa resolução. 

Thermal Camera Saídas​: mapa de reflectância térmica. 
Entrada típica​: câmeras térmicas (Tau 2 based: FLIR Vue Pro, 
thermoMAP, etc.). 
Aplicações​: irrigação, painéis solares, etc. 

 

Como criar um projeto 
Esta seção vai explicar passo a passo o processo de criação de um novo projeto. Exemplos de 

14 

https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label3
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label4
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label5
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label6
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label6
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label7
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label7
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label8
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label8
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label9
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label9
https://support.pix4d.com/hc/en-us/articles/205319155-Processing-Options-Default-Templates#label10


 

conjuntos de dados de imagem podem ser baixados do ​Pix4D Knowledge Base​. 

Criando um novo projeto 
Para criar um novo projeto: 
1. Começar Pix4Dmapper. 
2. Na barra do menu, clicar em ​Project > New Project…

 
  
3. O Assistente  ​New Project​   é aberto
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4. No ​Name:​ digitar um nome para o projeto. 
5. (Opcional) Em ​Create in​: clicar em ​Browse...​  No menu pop-up ​Select Project Location​, 
navegar para selecionar a pasta onde o projeto e os resultados serão armazenados e clicar em 
Select Folder. 

Aviso​: Certifique-se de que: 

● O nome do projeto NÃO usa caracteres especiais. 
● O caminho onde o projeto será criado NÃO usa caractere (s) especial (is). 
● O nome do projeto e o caminho juntos contêm menos de 128 caracteres. 

6. (Opcional) Marcar a caixa de seleção ​Use As Default Project Location​ ​para salvar todos os 
novos projetos na pasta selecionada. 
7. Em ​Project Type, ​mantenha a opção padrão ​New Project​ selecionada. 
8. Clicar em ​Next​. 
 

Importando as imagens 
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Na janela ​Select Images​: 
1. Clicar em ​Add Images...​ ​para adicionar as imagens​. 

 
  
2. ​Na janela ​Select Images​ que aparece, navegar para selecionar a pasta onde as imagens são 
armazenadas, selecionar as imagens a serem importadas (é possível selecionar várias 
imagens) e clicar em ​Open. 
3. Clicar em ​Next​. 

Configurando as Propriedades das Imagens 
Há 3 etapas opcionais a seguir antes de clicar em​ ​Next​: 
 
a​. ​(opcional) Select Image Coordinate System 
Se a geolocalização das imagens for fornecida em um sistema de coordenadas diferente do 
WGS84 (padrão), clicar em ​Edit​... em ​Coordinate System​ e selecionar o sistema de 
coordenadas das suas imagens​. 
 
b​.​ ​(opcional, recomendado) Import Image Geolocation and Orientation 
Se a informação de localização geográfica (posição) estiver armazenada no EXIF das imagens, 
ela será carregada automaticamente. Nota: as informações de geolocalização também podem 
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ser importadas a partir de um arquivo, clicando ​From File...​.  

Nota​: 

● O software considera o campo ​Data de Captura​ do EXIF para configurar a 
ordem na qual as imagens são tiradas. 

● Step ​1. Initial Processing​  é mais rápido para projetos com geolocalização de 
imagem. No caso de sobreposição insuficiente a geolocalização da imagem 
ajuda a calibrar as imagens.  

  
c​. ​(opcional) Edit Selected Camera Model 
Um modelo de câmara precisa ser definido para executar um projeto no Pix4Dmapper. Os 
parâmetros deste modelo dependem da câmara que foi usada para capturar a imagem. A 
maioria das câmeras guarda seu nome nos metadados da imagem no formato EXIF. Este 
campo é utilizado para associar um determinado modelo de câmara a todas as imagens 
capturadas com esta câmara​.  
 
A seção ​Selected Camera Model​, na janela ​Image Properties​, exibe o modelo de câmera 
selecionado. O modelo da câmera pode ser​: 

○  ​Valid​: ​Um check verde é exibido se o modelo da câmera for válido. Um 
modelo de câmera é válido se já existir no banco de dados dos modelos de 
câmera do Pix4Dmapper ou se houver informações suficientes nos dados EXIF 
das imagens para criar um novo modelo de câmera que será salvo no banco de 
dados dos modelos de câmera do usuário. Se o modelo da câmera for 
recuperado dos dados EXIF, recomenda-se verificar os parâmetros do modelo 
da câmera e, se necessário, editá-los​.  

○  ​Invalid​: ​Uma cruz vermelha será exibida se o modelo da câmera não for 
válido. Um modelo de câmera é inválido se não estiver no banco de dados dos 
modelos de câmera do Pix4Dmapper e se não houver informações suficientes 
nos dados EXIF das imagens. Nesse caso, o modelo da câmera precisa ser 
definido manualmente​. 

Selecionar o Sistema de Coordenadas de Saída / GCP 

Na janela​ ​Select Output Coordinate System​: 
1. (opcional) Mudar o ​Output / GCP Coordinate System​. 

Nota​:  

● Por padrão, a saída e o sistema de coordenadas GCP serão iguais. Desta forma, 
as saídas podem ser mostradas no sistema de coordenadas das GCPs.. 

● Por predefinição, o​ ​Unit ​está em metros​ ​ (meters). 
● Se as imagens tiverem localização geográfica, por padrão, a opção ​Auto detected​ é 
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selecionada, exibindo a zona UTM ou NAD83 correspondente das imagens.  
● Se as imagens não tiverem geolocalização, por padrão ​Arbitrary Coordinate 

System​ é selecionado. 
2. Clicar em ​Next​. 

 
 
Selecionando as Opções de Processamento 

Na janela ​Processing Options Template​: 
1. ​Selecionar o modelo desejado de acordo com o aplicativo e as saídas desejadas descritas 
na seção​ ​Modelos de opções de processamento. 
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2. (opcional) ​Selecionar ​Start Processing Now​ para iniciar automaticamente o processamento​. 
3. Clicar em ​Finish ​para concluir o assistente e iniciar o projeto​. 

Etapas de Processamento 
Esta seção descreve as três etapas para um processamento com Pix4Dmapper.  
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1. Processamento Inicial 
Nesta etapa, as imagens e os dados adicionais, como os GCPs descritos na seção ​Entradas 
serão usadas para realizar as seguintes tarefas:  

● Keypoints extraction​: Identificar nas imagens recursos específicos como pontos-chave 
● Keypoints matching​: Encontrar quais imagens têm os mesmos pontos-chave e 

combiná-los.  
● Camera model optimization​: Calibrar os parâmetros internos (distância focal, ...) e 

externos (orientação, ...) da câmara.  
● Geolocation GPS/GCP​: Localizar o modelo, se as informações de geolocalização 

foram fornecidas.  
 
Os Pontos de enlace são criados automaticamente durante esta etapa. Esses são a base para 
as próximas etapas de processamento.  
 
Para obter mais informações sobre as saídas, consulte a seção ​Saídas​. 

2. Nuvem de Pontos e Malhas 
Esta etapa irá construir em cima dos Pontos de Enlace:  

● Uma Densificação de pontos​: mais Pontos de Enlace são criados sobre os existentes 
para obter uma ​Nuvem de Pontos Densificada​.  

● Malhas Texturizadas em 3D​: com base na nuvem de pontos densificada, pode-se criar 
uma malha texturizada 3D. 

3. MDS, Mosaico de Ortofotos e Índices 
Esta etapa permite a geração de:  

● Modelo Digital da Superfície  (MDS)​: A geração do MDS permitirá a computação de 
Volumes e a geração de Ortomosaicos e Mapas de Reflectância. 

● Ortomosaico​: A criação do Ortomosaicos é baseada na ortorretificação. Este método 
remove as distorções de perspectiva das imagens.  

● Mapa de Reflectância​: O objetivo é produzir um mapa onde o valor de cada pixel 
fielmente indique a reflectância do objeto.  

● Mapa de Indices​: Gera um Mapa de Índices onde a cor de cada pixel é calculada 
usando uma fórmula que combina diferentes bandas do (s) Mapa (s) de Reflectância. 

 
Pontos de Controle (GCPs) 
Esse método é usado quando ​a geolocalização das imagens e os GCPs estão em um 
sistema de coordenadas conhecido​ que pode ser selecionado a partir do banco de dados de 
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sistemas de coordenadas do Pix4Dmapper. Os dois sistemas não precisam ser os mesmos. 
Pix4Dmapper é capaz de fazer a conversão entre dois sistemas de coordenadas conhecidos. 
 
Este é o ​CASO MAIS COMUM​ e torna possível marcar os GCPs nas imagens com pouca 
intervenção manual. No entanto, este método não é adequado para o processamento "de noite" 
durante o qual os diferentes passos de processamento começam automaticamente numa 
sequência e não requerem qualquer supervisão pelo utilizador. 
 

Instruções 
1. Obter GCPs medidos no campo ou através de outras fontes.  
2. Adicionar / Importar os GCPs com o Gerenciador ​GCP / MTP Manager​ ​SEM​ marcá-los. 
3. Na barra de menus, clicar em ​View > Processing​. A ​barra de processamento​ aparece na 
parte inferior da janela principal. 
4. Selecionar  ​1. Initial Processing  ​e desmarcar  ​2. Point Cloud and Mesh ​e  ​3. DSM, 
Orthomosaic and Index​. 
5. Clicar em ​Start​. 

 
6. Uma vez concluído o ​Initial Processing​, marcar os GCPs no rayCloud.  Na barra lateral 
esquerda, na seção Layers, clicar em ​Tie Points​ e, em seguida, clicar em ​GCPs / MTPs​. A lista 
dos GCPs é exibida. Selecione um GCP no layer ​GCPs / MTPs​: a barra lateral direita exibe 
suas propriedades e a lista de imagens em que está visível. Marcar a posição exata do GCP 
em pelo menos 2 imagens usando o clique do botão esquerdo do mouse. Quando a cruz verde 
está na posição correta na maioria das imagens, clicar em ​Apply​. 
7. Clicar em  ​Process > Reoptimize​. 
8. (opcional) Regenere o Relatório de Qualidade clicando em ​Process > Generate Quality 
Report​. 
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